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Introduction 
 

Welcome to WinCALIS! 
This guide is provided for both Authors and Students using WinCALIS.  It describes the structure and 
layout of the program and its components, explains features and how to apply them, and details certain 
language specifics.  You are invited to browse through this guide before you use WinCALIS, and to keep it 
as a reference while you use WinCALIS.   

 

We hope that you enjoy your work with WinCALIS, and contact us at the Humanities Computing 
Laboratory with any comments, ideas, or suggestions for improvement.  After all – it was designed for 
people like you! 

 

What is WinCALIS? 
CALIS is the ”Computer-Assisted Language Instruction System." It combines the most innovative 
concepts of Computer-Assisted Learning with the soundest pedagogical principles to equip language 
teachers with a stimulating educational tool, giving language students personalized and effective language 
learning materials for the computer.  Language learning is enhanced in the classroom, the language lab, 
or the home, with the features and powers of WinCALIS.   

 

Copyright Information 
© Copyright 2001 by the Humanities Computing Laboratory. 

All rights reserved. 

No part of this publication may be reproduced, transmitted, or transcribed, stored into a retrieval system or 
translated into any language or computer language, in any form or by any means, electronic, mechanical, 
magnetic, optical, chemical, manual or otherwise, without the prior written consent of the Humanities 
Computing Laboratory. 

The Humanities Computing Laboratory reserves the right to revise this publication and to make changes 
from time to time in the content of this publication without obligation of the Humanities Computing 
Laboratory to notify any person of such revision. 

Microsoft is a registered trademark of Microsoft Corporation; Windows is a trademark of Microsoft 
Corporation. 

IBM is a registered trademark of International Business Machines Corporation and PC-AT and PS/2 are 
trademarks of International Business Machines. 

Unicode is a registered trademark of the Unicode Consortium. 

 

WinCALIS Support Services 
You may contact The Humanities Computing Laboratory or its agents for Technical Assistance regarding 
the functionality of the program, its subset of commands, and the way the software works with the 
hardware, all as stated in the documentation.  

No matter how you choose to contact us, please be prepared to provide the following information: 

•  Your Registration Number 

•  Product version number listed found by choosing About from the Help menu in UniEdit. 
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•  The type of computer hardware you are using. 

 Optionally, and according to the type of question you may have, also provide us with the 
following: 

•  Software version of Microsoft Windows. 

•  Contents of the WINCALIS.INI file. 

•  Exact wording of any messages on the screen. 

•  What you were doing when the problem occurred. 

•  How you tried to solve the problem. 

 
E-Mail 

Ask questions and receive help from Technical Support via e-mail, which is by far the most flexible way of 
getting support. Just send the electronic mail to the accounts listed below. This option is given the highest 
priority. 

(USA)  info@humancomp.org 

(Argentina) bpascal@ciudad.com.ar 

 

World Wide Web 

http://www.humancomp.org, the Humanities Computing Laboratory Home Page, provides information 
about products, events, and technical support.  

 

Fax 

Feel free to send us your product orders, questions or comments.  Our fax numbers are: 

In the USA: 919-667-9556 

In Argentina: +54 1 4432-8353 / 8358 (15) 4181-9904 

 

Telephone 

If you would like to talk to us in person, or if you have questions you would like to ask us, use these 
telephone numbers. You can reach Technical Support by phone between 9:00 A.M. and 6:00 P.M. EST, 
Monday through Friday. When you call, you should be at your computer and have your documentation at 
hand. Be prepared to provide the information as requested on the previous page. 

In the USA: 919-667-9556 

In Argentina: +54 1 4432-8353 / 8358 
 

Address 

Please feel free to write us at the following addresses: 

In the USA: 

Humanities Computing Laboratory 
301 W. Main St., Suite 400-I 
Durham, NC 27701 USA 
 
In Argentina: 

Centro Blas Pascal  
Investigación Y Desarrollo En Informática Educativa  
Bacacay 705 - piso 11 "B" 
Ciudad de Buenos Aires 
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Buenos Aires, Argentina 
  

You must be a registered user to access Humanities Computing Laboratory’s or any of its agents’ Support Services. 
Support Services are subject to prices, terms, and conditions in place at the time the service is used.  
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Getting Started with WinCALIS  

System Requirements 
Before you begin the installation process, make sure that you have all the hardware and software you 
need to run WinCALIS.  At minimum, you will need the following: 

 

•  A personal computer with an Intel 80486 or higher processor and a minimum of 16MB RAM 
memory. 

•  A graphics adapter and monitor supporting standard VGA or higher resolution. 

•  A hard disk with at least 4MB of free disk space (10MB for a complete installation) and a 
CD-ROM drive or network connection for software installation.  

•   Windows 3.1 or higher running on your machine. 

 

Note:  Because some WinCALIS features are not easily accessible from the keyboard, the use of a mouse is 
recommended. 
 

Installation (WinCALIS) 
• To install WinCALIS, you will need to run a setup program which decompresses the files to your hard 

drive.  To do this: 

• Insert the WinCALIS installation CD into your CD-ROM drive 

• In Windows 3.xx, follow the on-screen directions to install WinCALIS ver.2.3 from the folder 
\install\win16\student\setup.exe.  

• In Windows 9x/NT/2000, follow the on-screen directions to install WinCALIS ver.2.5 from the 
folder \install\win32\student\setup.exe.  

 

Note:  You  may exit at any time during the setup procedure. 
 

The first thing you will be asked to do is enter your name and institute or affiliation. When you press Enter, 
you will proceed to the next screen which will verify that the information you just entered is correct.  Next, 
setup will inform you of the file(s) that it will install automatically.   

 

Next, setup will indicate a default drive and directory where the programs will be installed, unless you 
specify an alternate drive and/or directory.  You will also be provided with information on space required 
and space available on the hard drive. 

 

Note: In the 16-bit Setup for Windows 3.1, if you click on "Install" at this point, only WinCALIS will be installed. To 
install additional files (supplemental languages, conversion filters, etc.), click on the Optional Files button. 
 

Choose Individual Files 
If you clicked on the Optional files button, a dialog box will appear listing various file options.  You can 
choose to install only that part of WinCALIS you will be working with by clicking on the desired files with 
the mouse, or select the All button.  When you have made your selections, press the Continue button.  If 
the All button is chosen, Setup will install all modules available in WinCALIS. For each optional module, 
you must have the appropriate license and installation media. 
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Once the files are chosen, click on the Install button. WinCALIS will verify that you have sufficient space 
on your hard disk before beginning installation.  

 

An overview of WinCALIS fundamentals is available as a part of the installation package.  

 

WinCALIS Structure 
There are two different versions of the WinCALIS program--a standard version for student workstations 
and a special version for use on author workstations. A WinCALIS student workstation consists of three 
main components: WinCALIS, for running lessons, the WinCALIS Composition Editor, for general 
multilingual writing tasks, and a multilingual printer program.  

 

Starting WinCALIS  
When viewing the WinCALIS program group, you will see several program-item icons, one for each of the 
components of the package. We will now examine how to start WinCALIS, move around in the WinCALIS 
environment, and work a WinCALIS lesson.  If you are unfamiliar with Microsoft Windows, please go 
through the demonstration program provided for you on Microsoft Windows or check your Microsoft 
Windows User's Guide.   

 

After you have installed WinCALIS, select the WinCALIS program icon to start it.  You will be presented 
with the opening screen, welcoming you to WinCALIS.  At this point you have some decisions to make 
about the directory location and format of the lesson you wish to run, and how you want the screen to look.  
As explained below, you use the Options choice on the main menu bar.  To help you understand all of 
your options, the on-line help system is always available. After you have things the way you want them, 
you can select and run the desired lesson. Any changes you make in the menu options will be in effect 
until you change them again, so you do not have to reset them every time you run WinCALIS. 

 

All of these features and decisions are controlled by menu items on the main menu as explained in the 
section WinCALIS Opening Screen Menus and Layout 

 

WinCALIS Opening Screen Menus and Layout 
 

Menu Bar 
The Menu Bar in the opening WinCALIS screen contains two menus, Options, and Help.  You may open 
one of these menus by clicking on it with the mouse or by pressing the Alt key and the underlined letter in 
the menu simultaneously. 

 

After you open a menu you can select an item from it by clicking on that item or by pressing the key of the 
underlined letter in the menu item.  (Note you do not have to press the Alt key in this instance.) 

 

Options Menu (WinCALIS Opening Screen) 
 

Show [Files of Type] (WinCALIS v.2.5 and later) 
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WinCALIS can run lessons in three different formats, editable Unicode-text *.CAL files, *.WCL Unicode-
binary files, and lessons packaged in *.ZIP archives. Normally the WinCALIS Student Workstation does 
not include Unicode-text *.CAL files. The *.ZIP format is especially suited to efficient distribution and 
downloading from the Internet. The default WinCALIS file format and extension is *.WCL. 

 

Download Exercises from Internet... (WinCALIS v.2.5 and later) 

Displays a dialog box allowing you to access a lesson using the World Wide Web HTTP or FTP protocols. 

 

For additional Options menu items available on the Author Workstation version of WinCALIS, see also 
Author Workstation Version of WinCALIS. 

 

Help Menu (WinCALIS Opening Screen) 
WinCALIS comes with an extensive on-line help system.  You can find your answer quickly, using the on-
line help.  Clicking on the Help menu, pressing F1, or pressing Alt+H will get you the help you need 
instantly. 

 

Index 

The index provides the user with several categories of help topics ranging from "Choosing a lesson" to 
"Working efficiently".  These topics function as mini-lessons about WinCALIS. You may also use the 
Search and Browse features to locate the information you need.  

 

Selection Window 

This topic explains the WinCALIS opening screen and lesson selection window. 

 

About WinCALIS 

About WinCALIS shows the current version and date of your copy of WinCALIS.  It also displays the 
registration number of the package and the name it is registered to. 
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WinCALIS Opening Screen Layout 
The screen is divided into three main areas beneath the menu bar, each communicating information about 
lessons and the directories in which they reside.  Each area is described below. 

 

 

Figure 1: WinCALIS Opening Screen 

 

Lesson Window 
In the lower left corner of the screen, beneath the "Look in: [directory path]" dropdown box, you will find an 
alphabetized list of all the WinCALIS lessons in the selected folder.  You may use the directional arrows or 
click the mouse to highlight the lesson. Press Enter or double-click to start the lesson.  You may also click 
on the Run button below the Lesson Window. 

 

Lesson Description (Comment) Window 
For each lesson in the Lesson Window there may be an associated message or statement displayed in 
the Lesson Description Window.  It usually summarizes the content or objective of a lesson, helping you to 
prepare mentally before starting the lesson. Other information, such as a reminder about tutorials 
available in the lesson, can also be displayed.  If the author has not specified a lesson description, the 
message "Welcome to WinCALIS" will be displayed. 

 

Command Buttons 
You may click on Run to begin the selected lesson or click on Exit to exit WinCALIS and return to the 
Windows Program manager. 

 

Directory Path Dropdown Box 
On the lower left, above the Lesson Window, you will see a dropdown box showing the current directory or 
folder. Click on the downward-pointing arrow to display a list of available drives and directories, then click 
on the desired directory.  The Lesson Window will display all WinCALIS lessons contained within the 
highlighted directory.  

 

Directory Description Window 

Lesson 
Window 

Directory Description 
Window 

Directory Path 
Dropdown Box 

Lesson Description 
(Comment) Window 

Command 
Buttons 
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In the lower right-hand corner, you will find the Directory Description Window, where the author may 
display a message concerning the directory highlighted in the Directory Window. Authors can convey 
preliminary instructions, objectives, or other information about the group of lessons in the highlighted 
directory.  This is accomplished by placing a Unicode text file in the directory called "WINCALIS.DIR," 
containing the information to be displayed in the Directory Description Window. This file may contain 
formatting commands, graphics, and most other CALIS commands, as long as they do not reference 
another window. 

 

Note: If there is no "WINCALIS.DIR" file in the highlighted directory, then the WinCALIS Pangaea logo will  be 
displayed. 
 

Author Workstation Version of WinCALIS 
 

Options Menu (WinCALIS Opening Screen)  

Author Workstation Additional Options 
 

Show All Applicable Files (*.WCL, *CAL, *.ZIP) 

 

*. WCL only (No Conversion) 

Only those lessons in the current directory in the WinCALIS binary file format (with the extension *.wcl) will 
be displayed in the Lesson Window.  Lessons created by WinCALIS Author are automatically converted to 
this format by WinCALIS. 

 

*.CAL only (Text Conversion) 

Only those lessons in the current directory in Unicode text format (extension *.cal) will be displayed.  
These lessons may be edited using WinCALIS Author Scratchpad and are converted to the WinCALIS 
Unicode binary-file format (extension *.wcl) when run. 

 

*.ZIP only (Archive Conversion) 

Only those lessons in the current directory packaged in compress ZIP archives (extension *.zip) will be 
displayed.  These lessons would normally be used for safe and fast Internet distribution of lessons which 
contain ancillary text, image, audio and video files, in addition to the core *.WCL script file. 

 

Note: You may change the default setting so that WinCALIS starts up on your Workstation in any display mode. Use 
the Windows Notepad or other plain-text editor to edit the "ListBoxDisplay=" line in the [WinCALIS] section of the 
WinCALIS initialization file WINCALIS.INI, in the main WinCALIS program directory (usually the parent directory 
of the default scripts directory). The values are as follows: 

 ListBoxDisplay=0 (sets No Conversion *.WCL mode) 
 ListBoxDisplay=1 (sets No Conversion *.CAL mode) 
 ListBoxDisplay=2 (sets Archive Conversion *.ZIP mode). 

 

 

Window defaults... 

Specifies the aesthetic qualities of the screen in each of the various windows that WinCALIS employs.   
Each WinCALIS window may have different characteristics, as indicated in the drop-down boxes in 
Window defaults. The five windows are: 
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Interactive (Question), Presentation (Text), Tutorial, Directions, and Diagnostic / Directed Feedback. 

 

For each window, you may specify the text color, style (e.g. bold, italic, etc.), font size and background 
color.  

 

Note: The option to switch between "No conversion"/“Archive conversion,” and "Text conversion," and the option to 
set "Window defaults" are usually found only on the Author Workstation version of WinCALIS. If a system 
administrator wishes to reset the defaults for a Student Workstation, he can temporarily replace the Student 
Workstation version of WINCALIS.EXE with the Author Workstation version of WINCALIS.EXE, change the 
window defaults to the desired settings, then restore the original WINCALIS.EXE. All settings are written to the 
WINCALIS.INI file in the program directory. See WinCALIS Author on-line Help for more information about 
customizing the workstation. 
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WinCALIS Menus 
 

 

 

Lesson Menu 
 

Quit Lesson   Esc 
Terminates the current lesson and returns you to the WinCALIS opening screen in order to select a new 
lesson. 

 

Save Window Contents As... 
Allows you to save the contents of the selected window to a file on disk.  WinCALIS will prompt you to 
decide which window contents you wish to save. 

 

Exit WinCALIS 
Terminates WinCALIS altogether. 

 

Options Menu 
 

Add Accent  F2 
Selecting the menu item "Add Accent," or pressing the shortcut key F2, will highlight the letter to the left of 
the insertion point (with blinking caret) and the next letter pressed will overstrike the highlighted letter as a 
diacritical modifying accent (grave, acute, circumflex, tilde, diaeresis, etc.).  See the section Accents and 
Diacritics. 

 

Switch Languages  F3 
Selecting the menu item "Switch Languages," or pressing the shortcut key F3, will switch between the 
currently selected language and the top menu language (by default  English/W. Europe,  the ANSI/Latin1 
keyboard). 

 

Note: The "top" language is determined by the default language .INI file defined in the "DefaultIni=" line in the 
[WinCALIS] section of the main WinCALIS initialization file "winCALIS.ini," in the WinCALIS program directory. 
The default language .INI file is set by default for the United States and Western Europe to "latin1.ini."  If the default 
.INI file is changed to some other language .INI file, the "top" language will also be changed accordingly. The initial 
language for use on startup in WinCALIS and WinCALIS Author (also by default set to English/W.Europe) is also 
customizable by the courseware author or WinCALIS system administrator.  The initial language is determined by the 
setting of the InitialLanguage= line in the  [Initial] section of the "winCALIS.ini" file. The out-of-the-box value for this 
line is InitialLanguage=English/W.Europe. 
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Give Up  F6 
By choosing the Give Up option or pressing F6, you may (in some circumstances) give up when you do 
not know the answer.  The correct answer will then be displayed. By default, you may not give up on a 
particular answer until after attempting the question at least once.  Students are generally discouraged 
from giving up too soon, so that they are challenged to rethink their answers.  Also WinCALIS gives you 
the option of passing a question and returning to it later.  (See Pass Back, Pass Forward below.) 

 

Directions  F9 
By choosing the Directions option or pressing F9, you may call the Directions Window to the screen. 

 

Play Audio  F11 
When prompted to do so by the directions, you may play an audio clip provided by the author of the 
lesson. Clicking on "Play Audio" or pressing F11 will always play the most recently played clip. 

 

Play Video  F12 
When prompted to do so by the directions, you may play a video clip provided by the author of the lesson. 
Clicking on "Play Video" or pressing F12 will always play the most recently played clip. 

 

Unicode Browser... 
Allows you to browse through the Unicode character tables and insert a character in your text.  

 

See Unicode Character Selection Dialog Box. 

 

Media Controls 
At the author's discretion, a media controls bar is displayed for you to control the playback through the 
Windows Media Control Interface (MCI) of the current, or most recently played, audio or video clip. You 
can suppress the display of this Media Control by deselecting it here. If there is no audio or video available 
the menu item is dimmed. 

 

Previous Answer  Up Arrow 
You can display the answer you just entered on the student response line by clicking on this menu item or 
pressing the Up Arrow key on the cursor control keypad. 

 

Pass Back  Gray - and Pass Forward  Gray +  
 

By choosing these options or pressing the Pass Forward keys, gray "+" or Ctrl+PageDown or Ctrl+N, or 
the Pass Back keys, gray "-" or Ctrl+PageUp or Ctrl+P, you may browse back and forth through questions 
and presentation screens.  Instead of giving up, if you do not know the answer to a question, you can go 
on and answer the succeeding questions, which may provide a clue to answering the preceding one. 
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Note: As a convenience for laptop users, WinCALIS now also supports the additional Pass Forward keys 
Ctrl+PageDown or Ctrl+N and the additional Pass Back keys Ctrl+PageUp or Ctrl+P.  
 

Tutorials Menu 
The author may include supplementary instructions with the lesson to help you answer the questions. This 
information is accessed via the Tutorials option.   

 

By clicking on the Tutorials option or pressing Alt+T, a list of all tutorial options will be displayed, along with 
their access keys.  Double-clicking on the specific tutorial or pressing Shift and the appropriate function 
key will open the window.  

 

Language Menu 
At times it may be necessary for you to switch language keyboards. 

 

When the language pull-down menu is opened, all supported language keyboard arrangements will be 
displayed.  Language keyboards are grouped into sub-menus either by geographic region (e.g., Europe 
other, Japanese) or by script family (e.g., Arabic, Cyrillic, Indic). By double-clicking on a language 
keyboard or highlighting it and pressing Enter, you determine the character correspondence of the 
keyboard.  See the Keyboard and the Accents and Diacritics sections. Note that by pressing the shortcut 
key F3 or selecting the "Switch Languages" option under the Options menu, you can toggle between the 
currently selected keyboard and the top keyboard (usually "English/W. Europe"). 

 

Western European languages such as Danish, English, French, German, Italian, Portuguese, Spanish, 
and Swedish are all available with the ANSI (Latin1) Roman character set and default "English/W.Europe" 
keyboard (no keyboard change required).  All accents are typed with three keystrokes (base letter + F2 + 
accent).  

 

 

Figure 2: Keyboard Help 

 

See Also 

Specific Language Reference Manuals 

 

Tools Menu 
 

Language Options 
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Editing options which are specific to particular languages are grouped under this menu item. Each 
language has its own cascading submenu. 

 

 Chinese Options 

   

Reselect ("Oops") F9 

Character Search F7 

All-tone Search F8 

Default Selection/Repeat F10 

Set Cache/No-Cache Search Mode Alt+F3 

Set Convert/No-Convert  Mode Alt+F5 

Set Word/Character Search  Mode Alt+F7 

Set Tone/All-Tone Search  Mode Alt+F8 

Set Simple/Complex Style Alt+F9 

Set Default/No-Default Search  Mode Alt+F10 

Set Word/Character Search  Mode Alt+F7 

 

These menu options alter the Chinese pinyin-Hanzi conversion process. For an explanation of the various 
Chinese conversion settings and search options, see the topic Chinese Function Keys or the general 
Chinese Language Reference (requires separate CJKV module).  

 

  More Options...  Alt+F11 
 

If the current language keyboard is Chinese Pinyin-to-Hanzi, selecting the menu item Tools, Language 
Options, Chinese Options, More Options will display the Chinese Dictionary Search Options dialog box, 
with the current settings for Chinese input. These settings can be changed either by clicking with the 
mouse or by pressing the corresponding Alt + function key combination. 

 

  Set Disk/No-Disk Search  Mode Alt+F12 
 

As with the other menu options above this option alters the Chinese pinyin-Hanzi conversion process. See 
the topic Chinese Function Keys or the general Chinese Language Reference (requires separate CJKV 
module).  

 

  Chinese Status Bar 
 

When you choose Chinese Pinyin-to Hanzi as the active language keyboard, the Chinese Status Bar will 
pop up by default, displaying the current settings for Chinese input. 

 

The Status Bar may be turned off by deselecting it here. If Chinese Pinyin-to-Hanzi is not the currently 
selected language,  the menu item is dimmed.  
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See Chinese Status Bar (requires separate CJKV module).  

 

 Japanese Options 

  View Japanese Dictionary... 
 

Allows you to view and edit the Japanese internal Kana-Kanji conversion dictionary. (Currently disabled.) 
See Japanese (requires separate CJKV module). 

 

Korean  Options 

  Hanja-to-Hangul F7 
 

To convert the syllable or word to the left of the insertion point (the blinking caret) written in Hangul into its 
Hanja equivalent, press the F8 function key, or click on the menu item Tools, Language Options, Korean 
Options, Hangul-to-Hanja. 

 

  Hangul-to-Hanja F8 
 

To convert the syllable or word to the left of the insertion point (the blinking caret) written in Hanja into its 
Hangul equivalent, press the F7 function key, or click on the menu item Tools, Language Options, Korean 
Options, Hanja-to-Hangul. 

 

See Korean (requires separate CJKV module). 

 

Look Up Word... F5 
If an on-line dictionary has been supplied to accompany your exercises, selecting this menu option will 
open a dialog box, allowing you to look up the meaning or pronunciation of a selected word or phrase. 
Depending on how the dictionary was installed, it is either accessible only from specific language 
keyboards (e.g, for a Korean-English dictionary, the current keyboard must be one of the Korean 
keyboards), or accessible from any language keyboard which does not have a specific dictionary linked to 
it (e.g, for a Korean-English dictionary, the current keyboard could be either the default English/W. Europe 
keyboard or any of the Korean keyboards). 

 

In order to select a word to look up, follow one of the following three methods.  

 

•  Holding down the right mouse button, drag the mouse across the word you wish to mark for 
looking up. The marked word will appear highlighted in a pop-up box in the lower part of the 
screen. Press the space bar or click the mouse in the box to close it, then press F5 or click 
on the menu item Tools, Look Up Word... to look up the marked word. 

•  Copy the entire contents of a WinCALIS window directly to the “Dictionary Mode Window,” 
by selecting the menu item Tools, Dictionary Mode Window. First you will be asked to select 
the window to be copied. Then the WinCALIS Composition Editor will automatically be 
launched with the clipboard text pasted into the Dictionary Mode Window, ready for looking 
up. Drag the mouse across the word or phrase to be looked up (or double click on it if it is a 
single word) to highlight it. Then press F5 or click on the menu item Tools, Look Up Word... 
in the Composition Editor to look up the word. Repeat as often as desired. To return to 
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WinCALIS, either exit the Composition Editor or leave it running for further use and switch 
to WinCALIS by using the Windows shortcut key Alt+Tab. 

•  Copy the entire contents of a WinCALIS window to the Windows clipboard by selecting the 
menu item Tools, Copy Window to Clipboard. Then use Alt+Tab to switch to the WinCALIS 
Composition Editor (a special version of UniEdit). If this is not yet running, launch it by 
selecting the Composition Editor menu item from the Tools menu. Paste the clipboard 
contents into any document window. Then proceed as in the previous method to drag the 
mouse across the word or phrase to be looked up (or double click on it if it is a single word) 
to highlight it. Then press F5 or click on the menu item Tools, Look Up Word... in the 
Composition Editor to look up the word. Repeat as often as desired. To return to WinCALIS, 
either exit the Composition Editor or leave it running for further use and switch to WinCALIS 
by using the Windows shortcut key Alt+Tab. 

 

You can press the Escape key at any time during a search to cancel further searching and display the 
matches found thus far. 

 

Dictionary Mode Window... 
Selecting this item launches the WinCALIS Composition Editor (a special version of UniEdit) and copies 
and pastes the text contents of a selected WinCALIS window to a “Dictionary Mode Window,” from where 
words can be easily highlighted and looked up in an on-line dictionary. A Select Window dialog box allows 
you to choose which window’s contents to copy and paste.  

 

If the WinCALIS Composition Editor has already been launched and is currently running in the 
background, use the Tools, Copy Window to Clipboard" menu item to copy a window the clipboard, then 
switch to the Composition Editor with the Windows shortcut key Alt+Tab, and paste the window contents 
there. Then proceed to highlight and look up desired words there. 

 

Copy Window to Clipboard... 
Selecting this item copies the text contents of a selected WinCALIS window to the Windows clipboard. A 
Select Window dialog box allows you to choose which window’s contents to copy. 

 

Composition Editor 
Selecting this item launches the WinCALIS Composition Editor (a special version of UniEdit).  
Composition Editor is a multilingual text editor which allows creating, editing, saving, and printing of files in 
any combination of languages that WinCALIS supports. To return to WinCALIS, either exit the 
Composition Editor (save your work if you wish to) or leave it running for further use and switch to 
WinCALIS by using the Windows shortcut key Alt+Tab. 

 

Language functionality and keyboards are accessed in the Composition Editor as found in this Help Guide.  
Help on other editing functions and Tools may be obtained by contacting your computer administrator, 
your WinCALIS distributor, or the Humanities Computing Laboratory. 

 

Check Spelling 
If a spelling checker has been installed on your workstation and linked to WinCALIS, selecting this option 
will start the spelling checker. A copy of the spelling checker WinSpell® 3.0 is included with the WinCALIS 
workstation setup. 
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Print File (TrueType) 
Selecting this item launches the WinCALIS TrueType Multilingual Printer Program. 

 

Tools Menu Readme 
Selecting this item displays information about the Tools menu and some of its functions. 

 

Help Menu 
 

General 
Provides the same general help as the WinCALIS opening screen on broad topics ranging from "Choosing 
a lesson" to "Working efficiently". 

 

Virtual Keyboard 
By selecting this option, a window containing a graphic display of the current keyboard setup (i.e. which 
character is mapped to which key) will be displayed of the language in which one is working and also the 
procedure of using keystroke combinations to form diacritics.   

 

Author Help: 
This option gives access to a customized Help file for use with the Windows Help system for a particular 
exercise or group of exercises, if one has been supplied by the author of the exercise. 

 

About... 
About... shows the current version and date of your copy of WinCALIS.  It also displays the registration 
number of the package and the name to whom it is registered. 
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Running a WinCALIS Lesson 

 

Choosing a WinCALIS Lesson 
The opening WinCALIS screen contains three windows. 

 

The Lesson Window in the lower left corner of the opening screen contains a listing of all of the WinCALIS 
lessons contained in the current subdirectory. The current path and directory are displayed just above this 
window. 

 

Using the mouse or the numeric keypad you can highlight one of these lessons and begin to work it by 
double-clicking the mouse or by pressing the Enter key. 

 

When you highlight a lesson with the cursor control keypad or the mouse, a description of it appears in the 
Lesson Description Window at the top of the screen.  If no description exists, the message "Welcome to 
WinCALIS" will appear. 

 

The Directory Description Window in the lower right-hand corner contains information on the group of 
lessons in the current subdirectory provided by the creator of the lessons.  It may instruct you as to the 
proper order in which to work the WinCALIS exercises. 

 

If no such information for the current subdirectory exists, this window will display the WinCALIS Pangaea 
world map logo. 

 

Changing Directories 

Depending on the configuration of the machine on which WinCALIS is used you may have to change 
directories in order to find the lessons you wish to work. 

 

Your instructor should provide information on where the lessons you should work are located.  Check the 
Directory Description Window in the lower right hand corner of the opening menu window to see if such 
information exists.  If the window shows only a graphic, no information is available. 

 

The Directory Path Dropdown Box above the Lesson Window displays the current directory. To change 
directories, click on the down arrow icon, then click to move up or down to a different drive, parent 
directory, or subdirectory. 

 

Responding to a Task 

Answering questions in WinCALIS is easy.  (The RIGHT answer may be difficult!) 

 

Ideally, the author of the lesson you are working will provide instructions telling you what to do. Frequently 
an example is included as well.  If any Directions were given, then you can view them again by clicking on 
Options,Directions, or by pressing F9.  
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Since the Author program (the tool used to design WinCALIS lessons) allows an author to be flexible in 
the flow, aesthetics, and structure of a lesson and its individual tasks, then directions on how to respond to 
one task may not necessarily apply to another.  Here are some sample task types that you will likely 
encounter some variation of, and how to handle them: 

 

Multiple Choice 

You will presented with a set of choices.  After you decide on the best choice, either click any part of that 
choice (your mouse pointer will turn from an arrow to a hand when it glides over the “hot” area), or type the 
letter that corresponds to your choice.   

 

 

True/False 

This is handled much like the Multiple Choice: either click on your response choice, or tap the letter on the 
keyboard that corresponds to your choice.  Sometimes the two choices will be in the target language 
(Vrai/Faux), or they may be a choice of two possibilities (Right/Left; watch video/go back) 

 

Short Answer: typed input 

The blinking cursor usually is there to invite you to type in your answer. Decide on your language and 
keyboard, if appropriate, and type in your response.  After you are finished typing your answer, press Enter 
to send it back to WinCALIS.  Remember that you can recall your last typewritten response by pressing 
the up arrow Ç key, so you can easily edit and re-enter your response. 

 

 

Short Answer: buttons or hotspots 

WinCALIS can also check for your response in the form of a mouse-click on a certain part of the screen.  
You may click a button, click on a section of text that is marked as “hot”, or you can click on a certain 
graphic, or even a part of a graphic. 
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a sample button a sample of a hotspot on a 
graphic 

a sample of hot text 

 

Cloze 

This is a “fill-in-the-blank” type exercise.  The blinking cursor will be positioned at one of the blanks within 
the text, and your task is to fill it in. This is done by typing and entering the response, or by clicking on the 
item in the set of choices displayed.  A clue may associated with some of the blanks.   

 

 

 

Depending on the structure of the lesson you are working WinCALIS will respond with praise for a correct 
answer, and carry you to the next task or activity; or respond with an error message for an incorrect 
answer, and present you with the task again.  Or you may be moved to another part of the lesson based 
on the response you made and the intent of the lesson author.  If a box appears with feedback, then you 
will need to press the space bar, or click anywhere in the box to clear it and continue.   

 

Choose "Virtual Keyboard" from the Help menu if you are using a foreign character set and you are not 
familiar with the keyboard layout. 

 

Using Foreign Character Sets 

Sometimes you may be required to provide an answer using a foreign character set (such as Cyrillic or 
Arabic), or one which contains accented characters not available on your keyboard (such as French or 
German). 

 

An exercise may require that you alternate between the Roman character set and a foreign one. 
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In order to switch the keyboard to enable foreign character set input go to the pull-down menu labeled 
"Language" and click on it.  Or press Alt+L to open this menu. 

 

Use the mouse or numeric keypad to highlight the language keyboard you wish to use and double-click or 
press Enter. 

 

To return to the Roman character set repeat this procedure and select "English/W.Europe," or simply 
press F3 to toggle between the two language keyboards. 

 

Using Keyboard Help 

Open the "Help" menu and select "Virtual Keyboard". 

 

A window will appear showing the standard PC keyboard layout. 

 

If you have selected a foreign character set it will appear instead of the usual Roman characters.  (See 
Using Foreign Character Sets) 

 

For some foreign character sets you may also be able to produce characters not shown on the keyboard 
by using the overstrike key and an accent key. 

 

Click with the right mouse button on a highlighted “accent key” within the keyboard window or press it on 
the keyboard and it changes color from pale blue to red.  All of the accented or alternate characters it 
produces are displayed in green. Remember to display the shifted state of the keyboard as well, by 
pressing or clicking on the Shift key. Similarly, you can display more characters which can be inserted with 
a mouse click by pressing and holding Ctrl and Shift at the same time. 

 

To form an accented character, first enter it in unaccented form. Then press the overstrike key F2, and 
finally the appropriate accent key. 

 

In some cases accented or nonstandard characters are used to replace keys directly.  If so, you will see 
these characters when you bring up keyboard help. 

 

You may keep the keyboard window on-screen as you work.  Put it wherever you want by dragging it by 
the title bar. 

  

More on Accents and Diacritics 
In order to produce diacritics (i.e. a modification of a character, such as an accent) and to accommodate 
more characters than the standard English keyboard normally allows, combinations of keys are 
sometimes used. In order to modify characters with diacritics, one must gain a familiarity with the 
keyboard layout. 

 

The Overstrike Key = F2 
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The "overstrike key" F2 is used to make accents and diacritics.  It functions much like Ctrl, Shift and Alt 
keys on the standard keyboard. Pressing F2, or selecting the menu item "Options,Add Accent,"  will 
highlight the letter to the left of the insertion point (with blinking caret) and the next letter pressed will 
overstrike the highlighted letter as a diacritical modifying accent (grave, acute, circumflex, tilde, diaeresis, 
etc.). 

 

Accent Keys = Pale Blue 
Each diacritic is associated with a particular character on the keyboard, appearing in pale blue in the 
Keyboard Help virtual keyboard display.  An individual diacritic may modify several characters, such as a 
single accent working with several vowels.  In order to display the character set associated with a 
particular diacritic, right-click on one of the light blue accent keys or press the letter on the keyboard.   

 

Note: Because accents like the circumflex (^), the tilde (~), and the double quote ("), used to insert the umlaut, are  
shifted keys, Shift must be pressed along with the accent key. 
 

The accent key will turn red and the associated characters will appear in green.  In some cases there are 
more diacritics than displayed on the original Help keyboard.  Clicking on or pressing the Shift  and Ctrl 
keys will display additional accents and diacritics.   

  

Thus to see the full set of characters modified by the tilde (~), you must first press Shift + `, which will 
display the upper-case characters (shifted keys) modified by the tilde, then click on or press Shift again to 
display the lower-case characters (unshifted keys) modified by the tilde. 

 

Putting the Keys Together 
After the overstrike key, accent keys and their associated characters have been identified, the three may 
be used in conjunction to create an accented character.  The general procedure is to type the character 
itself, the overstrike key, and the accent key in that order.  Notice when the overstrike key has been 
pressed, the character appears in reverse video, ready to be modified with the diacritic. For example: 

ê Example 

Using the English/Western Europe keyboard (which supports all Roman languages) to create an ê: 

 

1. Type the lower case "e" 

2. Press the "overstrike key" F2 

3. Press Shift+6 

 

In order to create capital letters simply type the capital letter and then proceed as described above. 

 

At this point, you are prepared to tackle any WinCALIS lesson.  Lessons may vary in language, content, 
style, and pedagogical technique, but you are now equipped with the fundamental user knowledge needed 
to cope with most lessons.  If you need more help or practice, go through the demonstration again or any 
of the other lessons that come on the WinCALIS disks.  When you are comfortable with WinCALIS, you 
should move on to the real focus of this manual, which is authoring.  Like any form of creation, we believe 
that you will find authoring quite rewarding.  But unlike most forms of creation, you will find it quite easy 
when you use the WinCALIS authoring tool. 
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Giving Up and Seeing the Anticipated Response 
WinCALIS is very patient.  Unless the author of a lesson has specified otherwise, you may make as many 
attempts to answer a question as you like. 

 

If, after repeated attempts, you still cannot answer a question correctly, pressing the Giveup key F6 will 
show you the correct answer.  Or you can use the mouse to open the pull-down menu labeled Options and 
highlight Give Up. Release the mouse button and WinCALIS will show the correct answer. 

 

Usually you must make at least one attempt to answer a question, before you are allowed to see the 
correct answer. 

 

Beware! The lesson author can alter these rules, they are WinCALIS defaults which remain in effect until 
they are explicitly changed. 

 

You may have to make more than one attempt in order to enable giving up or it may not be possible to 
give up at all. 

 

Check the instructions for the lesson you are working to see if any instructions are provided regarding the 
use of the Giveup key. 

 

Completing a Lesson 
By default setting WinCALIS allows you yourself to judge whether you have completed a lesson 
successfully. 

 

After you have finished a lesson, WinCALIS will show you your score.  Then you will be returned to the 
WinCALIS opening screen. 

 

You may repeat a lesson as often as you like, even if you have already achieved a passing score. 

 

If you exit a lesson without finishing it your score will not be tallied. 

 

For example, answering 9 out of 10 questions correctly and then exiting the lesson will not count as a 
passing score. 

 

Working Efficiently 
To make the most effective use of your time spent working WinCALIS exercises, keep these tips in mind: 

 

•  Use the Up Arrow Ç cursor control key or the Up Arrow key on the numeric keypad to 
redisplay your answer when you make a mistake. 

 

Then use the cursor control keys to move to the point in your answer where you made a mistake and correct 
it. 
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This will save a lot of typing! 

 

•  Skip over tasks which are too difficult and come back to them later by pressing the Plus Key 
on the numeric keypad, or by pressing Ctrl+PageDown or Ctrl+N, or by selecting the pull-
down menu labeled Options and selecting Pass Forward. 

 

If the lesson author requires that you work the lesson in a specific order, trying to pass over a task will produce 
the message "You cannot pass this task." 

 

•  Try to guess the correct answer if you are not sure.  A well-written lesson should contain 
clues which will help you. 

 

Students have been known to type gibberish for a first attempt and then use the Giveup key to see the correct 
answer.  They next write down the correct answer and later repeat the lesson, with the answers in hand. 

 

However, this process usually takes more time than a sincere effort would. 

 

WARNINGS for Conversion From Older ".cal" Files to WinCALIS 2.x 
Unicode Files 

Generally, scripts written for CALIS for DOS run acceptably under WinCALIS, once their encoding has 
been converted. 

 

The following is a list of conflicts and inconsistencies between WinCALIS 2.x and text-based CALIS. 

 

•  Because Windows discourages the use of the Alt keys by an application, they are no longer 
used to call up help screens in WinCALIS.  In text-based CALIS, students could get help in 
a lesson (assuming it was available) by pressing the Alt key and one of the function keys 
between 1 and 10. 

 

In WinCALIS, the Shift key replaces the Alt key so that the student calls up help screens by pressing Shift and 
one of the function keys between 1 and 10. 

 

Text-based CALIS scripts which are converted for use with WinCALIS may contain messages which instruct 
students to use the Alt key.  These scripts will have to be edited or the author must in some way be sure that 
the student is made aware of this inaccuracy. 

 

•  Because of a conflict between the layout of accent keys in CALIS and Windows keyboard 
protocols, the WinCALIS accent keys have been redefined. 

 

Accents are mapped and displayed according to the file  "languagename.MAP" 

 

The layout of the keyboard and the key combinations for accents are dynamically displayed based on the 
"MAP" file.  Students can see this by selecting "Keyboard" from the "Help" menu.  This help also shows which 
accents are available and how they are produced.  See Using Keyboard Help. 
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For information on creating keyboard layouts and accent combinations see the WinCALIS Author help topic 
"Creating Custom Fonts and Keyboard Layouts." 

 

•  WinCALIS allows the student user to open multiple help windows using the Tutorials pull-
down menu or the Shift + Function keys.  Each of these windows can then be sized by the 
student. 

 

•  Change in format of feedback messages 

 

Text feedback provided by the author for correct and incorrect student responses is automatically centered in 
the diagnostic window.  (Assuming that the author has not specified that feedback appear in another window) 

 

This eliminates the need to use the <CEnter> command to cause feedback to appear in the center of the 
diagnostic window. 

 

• Text-based CALIS Commands Which Do Not Work With WinCALIS 

 
<TYPE> Ignored by WinCALIS 

 

•  Text-based CALIS Commands which are altered by WinCALIS 

 

<FLASH> WinCALIS displays text which has this attribute in red 

 

Unicode Character Selection Dialog Box 
The Unicode Character Selection dialog box enables you to browse through the Unicode tables for 
pleasure and edification. You may also insert a character in your text by going to its location in the table, 
either by scrolling through Unicode character blocks or by typing all or some of its hexadecimal Unicode 
character code in the edit box in the lower right corner. 

 

Figure 3: Unicode Browser 
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Hint: Clicking above or below the slider (or "scroll box")on the vertical scroll bar will scroll up or down a full "page" 
of 256 characters. To scroll up or down a half-page, so as to see all the characters on a page, press the up or down 
scroll arrows. If you move the focus to the window by clicking anywhere in the window, you may also move about with 
the cursor control keys.  Pressing PageUp or PageDown will scroll up or down a full page, while the arrow keys will 
move about a row or column at a time. 
 

The shortcut key to open the dialog box in WinCALIS Author is Ctrl+I. 

 

Here is a partial list of Unicode character "blocks," with their starting and ending hexadecimal Unicodes: 

 

Start End Block Name 

0020 007E BASIC LATIN 

00A0 00FF LATIN-1 SUPPLEMENT 

0100 017F LATIN EXTENDED-A 

0180 024F LATIN EXTENDED-B 

0250 02AF IPA EXTENSIONS 

02B0 02FF SPACING MODIFIER 
LETTERS 

0300 036F COMBINING DIACRITICAL 
MARKS 

0370 03CF BASIC GREEK 

03D0 03FF GREEK SYMBOLS AND 
COPTIC 

0400 04FF CYRILLIC 

0530 058F ARMENIAN 

0590 05CF HEBREW EXTENDED-A 

05D0 05EA BASIC HEBREW 

05EB 05FF HEBREW EXTENDED-B 

0600 0652 BASIC ARABIC 

0653 06FF ARABIC EXTENDED 

0900 097F DEVANAGARI 

0980 09FF BENGALI 

0A00 0A7F GURMUKHI 

0A80 0AFF GUJARATI 

0B00 0B7F ORIYA 

0B80 0BFF TAMIL 

0C00 0C7F TELUGU 

0C80 0CFF KANNADA 

0D00 0D7F MALAYALAM 

0E00 0E7F THAI 

0E80 0EFF LAO 

10A0 10CF GEORGIAN EXTENDED 

10D0 10FF BASIC GEORGIAN 

1100 11FF KOREAN HANGUL JAMO 

1E00 1EFF LATIN EXTENDED 
ADDITIONAL 

1F00 1FFF GREEK EXTENDED 

2000 206F GENERAL PUNCTUATION 

2070 209F SUPERSCRIPTS AND 
SUBSCRIPTS 

20A0 20CF CURRENCY SYMBOLS 

20D0 20FF COMBINING DIACRITICAL 
MARKS FOR SYMBOLS 

2100 214F LETTERLIKE SYMBOLS 

2150 218F NUMBER FORMS 

2190 21FF ARROWS 

2200 22FF MATHEMATICAL 
OPERATORS 

2300 23FF MISCELLANEOUS 
TECHNICAL 

2400 243F CONTROL PICTURES 

2440 245F OPTICAL CHARACTER 
RECOGNITION 

2460 24FF ENCLOSED 
ALPHANUMERICS 

2500 257F BOX DRAWING 

2580 259F BLOCK ELEMENTS 

25A0 25FF GEOMETRIC SHAPES 

2600 26FF MISCELLANEOUS 
SYMBOLS 

2700 27BF DINGBATS 

3000 303F CJK* SYMBOLS AND 
PUNCTUATION 

3040 309F HIRAGANA 

30A0 30FF KATAKANA 

3100 312F BOPOMOFO 

3130 318F HANGUL COMPATIBILITY 
JAMO 

3190 319F CJK* MISCELLANEOUS 

3200 32FF ENCLOSED CJK LETTERS 
AND MONTHS 

3300 33FF CJK* COMPATIBILITY 

3400 4DFF CJK* UNIFIED 
IDEOGRAPHS EXTENSION-
A 

4E00 9FFF CJK* UNIFIED 
IDEOGRAPHS 
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AC00 D7A3 KOREAN HANGUL (Unicode 
2.0) 

E000 F8FF PRIVATE USE AREA 

F900 FAFF CJK* COMPATIBILITY 
IDEOGRAPHS 

FB00 FB4F ALPHABETIC 
PRESENTATION FORMS 

FB50 FDFF ARABIC PRESENTATION 
FORMS-A 

FE20 FE2F COMBINING HALF MARKS 

FE30 FE4F CJK* COMPATIBILITY 
FORMS 

FE50 FE6F SMALL FORM VARIANTS 

FE70 FEFE ARABIC PRESENTATION 
FORMS-B 

FF00 FFEF HALFWIDTH AND 
FULLWIDTH FORMS 

FFF0 FFFD SPECIALS 

 

*"CJK" stands for Chinese-Japanese-Korean. For 
further Chinese-Japanese-Korean help, see also 
Kangxi Radical Chart (Chinese-Japanese-Korean) 
(requires separate CJK module). 

 

Select Window Dialog Box (Save Window Contents As…) 
Use this dialog box to indicate the window the contents of which you wish to save to a file on disk or copy 
to the clipboard. If you save to a file on disk you may then print the file with one of the WinCALIS printer 
utilities in your workstation.  

 

The window choices are the Presentation (Text) Window (which is usually the window at the top of the 
screen containing some text to be read); the Interactive (Question) Window (which appears below the 
Presentation (Text) Window, if any, and contains the question and your answer or other interaction with 
WinCALIS; the Directions Window (the window which appears at the beginning of an exercise or its 
subunits, or when you press F9); and the Tutorial Windows (which are popup windows listed under the 
Tutorials menu). Note that in order to save to a file or copy to the clipboard the contents of a Tutorial 
Window, you should first open it in WinCALIS by selecting it from the Tutorials Menu. Indicate the number 
of the Tutorial Window by the number of the "F" function shortcut key which opens it (shown in the Tutorial 
Menu and in the title bar of the Tutorial Window). E.g., for the Tutorial Window which is opened by 
pressing Shift+F2, type the number 2. 

  

User Information Window (Record-Keeping) 
Type your name and identification number (and password if required). WinCALIS will record your answers 
and score in a local file or in a remote Web database using the information you supply here. 
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User-Supplied On-line Dictionaries 
Tools Menu Option  "Look Up Word...   F5" 

You can type or highlight a word or phrase on the screen and look it up in an on-line dictionary, if one has 
been installed on your workstation.  

 

If an on-line dictionary has been installed to accompany WinCALIS exercises, selecting the menu option 
Look Up Word... from the Tools Menu, or pressing the shortcut key F5, will open the On-line Dictionary 
dialog box, allowing you to look up the meaning or pronunciation of a selected word or phrase. Depending 
on how the dictionary was installed, it can be either accessible only from specific language keyboards (e.g, 
for a Korean-English dictionary, the current keyboard must be one of the Korean keyboards), or 
accessible from any language keyboard which does not have a specific dictionary linked to it (e.g, for a 
Korean-English dictionary, the current keyboard could be either the default English/W. Europe keyboard or 
any of the Korean keyboards). 

 

A tiny sample dictionary of English has been included with the WinCALIS Demo exercises and Author 
Workstation Setup. It includes most of the vocabulary in the text "Turmoil at Grass Root Level" presented 
in the sample exercise "TURMOIL1.WCL." Try typing or marking a word like "keeper", "Manet", 
"arrondissement", "tax", or many other words. You can just mark the beginnings of words, especially 
inflected words, and WinCALIS will take care of the rest. 

 

Full-scale bilingual dictionaries are also available or under development for various languages. 

 

Help on Specific Language Dictionaries 
 

Japanese-and-English Dictionary  (Requires separate CJK module.) 

Korean-and-English Dictionary  (Requires separate CJK module.) 
 

How to Look Up a Word 
 

In WinCALIS you can type a word and look it up, or mark a word on the screen by dragging your mouse 
across it with the right mouse button depressed and look it up. You can also transfer the contents of an 
entire window to the WinCALIS Composition Editor and look up words from there. In the Composition 
Editor, WinCALIS Author, or UniEdit you can mark a word on the screen by dragging your mouse across it 
with the left button depressed, or double-click on a word and look it up.  

 

You can press the Escape key at any time during a search to cancel further searching and display the 
matches found thus far. However, since the Escape key has a special meaning in WinCALIS (quit an 
exercise), Escape can not be used in WinCALIS for the first search, only from subsequent searches when 
the On-line dictionary dialog is already displayed. 

 

In order to select a word to look up in WinCALIS, use one of the following three methods.  

Method 1: Marking Directly in WinCALIS 
 



 

36 

•  Holding down the right mouse button, drag the mouse across the word you wish to mark for 
looking up. The marked word will appear highlighted in a pop-up box in the lower part of the 
screen. 

•  Press the space bar or click the mouse in the box to close it. 

•  Press F5 or click on the menu item Tools, Look Up Word... to look up the marked word. 

Method 2: Using the Dictionary Mode Window 
 

•  Copy the entire contents of a WinCALIS window directly to the “Dictionary Mode Window,” 
by selecting the menu item Tools, Dictionary Mode Window. 

•  When the Select Window dialog box appears, select the window to be copied. 

•  Then the WinCALIS Composition Editor will automatically be launched with the clipboard 
text pasted into the Dictionary Mode Window, ready for looking up. 

•  Drag the mouse across the word or phrase to be looked up (or double click on it if it is a 
single word) to highlight it. 

•  Then press F5 or click on the menu item Tools, Look Up Word... in the Composition Editor 
to look up the word. Repeat as often as desired. 

•  To return to WinCALIS, either exit the Composition Editor or leave it running for further use 
and switch to WinCALIS by using the Windows shortcut key Alt+Tab. 

Method 3: Copying a Window to the Clipboard and Pasting in the Composition Editor 
 

•  Copy the entire contents of a WinCALIS window to the Windows clipboard by selecting the 
menu item Tools, Copy Window to Clipboard.  

•  When the Select Window dialog box appears, select the window to be copied. 

•  Then use Alt+Tab to switch to the WinCALIS Composition Editor (a special version of 
UniEdit). If this is not yet running, launch it by selecting the Composition Editor menu item 
from the Tools menu. Paste the clipboard contents into any document window.  

•  Then proceed as in Method 2 to drag the mouse across the word or phrase to be looked up 
(or double click on it if it is a single word) to highlight it.  

•  Then press F5 or click on the menu item Tools, Look Up Word... in the Composition Editor 
to look up the word. Repeat as often as desired.  

• To return to WinCALIS, either exit the Composition Editor or leave it running for further use and 
switch to WinCALIS by using the Windows shortcut key Alt+Tab. 
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The On-line Dictionary Dialog Box 

 

Figure 4: On-line Dictionary Box 

 

The On-line Dictionary Dialog Box contains various option settings in its upper part and a list box 
displaying the items found matching the word looked up in its lower part. Options are explained below. The 
words in the dictionary matching the word looked up are highlighted in reverse video. The total number of 
matches found is displayed in the title bar of the dialog box. 

 

Options in the On-line Dictionary Dialog Box 
 

Note: In order to understand the following options, note that an "entry" refers to an entire dictionary entry, which is 
enclosed in an outline box within the dictionary list box. You can scroll down through the displayed entries using the 
mouse and the scroll bar or using the PageDown, PageUp, and arrow keys. The term "field" is used to refer to the 
separate sections of a whole entry:  

•  the main entry field, highlighted in dark green, left justified on the first line of an entry 

•  the pronunciation or gender tag field, enclosed in square brackets, to the right on the first line 

•  the definition field(s), beginning on the second line of an entry 

 

Escape Key 
 

You can press the Escape key at any time during a search to cancel further searching and display the 
matches found thus far. However, since the Escape key has a special meaning in WinCALIS (quit an 
exercise), Escape can not be used in WinCALIS for the first search, only from subsequent searches when 
the On-line dictionary dialog is already displayed. 

Radio Button and Checkbox Options 

Search in: 
•  Main Entries 

Displays only the matches found in the main entry portion (field) of a full entry. The main entry field is 
displayed in dark green at the left margin of the first line of a full entry. Main entries are what the user of a 
dictionary most commonly searches for. This is the system startup default option. 

 

•  Everywhere 
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Displays matches found in all fields of a full entry (displayed in dark green or in black). 

 

Source 
•  Highlighted Text 

Uses the highlighted text as the word or phrase to look up. This is the system startup default option. 

 

•  Clipboard 

Uses the Unicode text currently on the Windows clipboard as the word or phrase to look up. This feature 
is primarily designed as a way to use the WinCALIS on-line dictionary system with other Unicode-
compliant applications. For looking up words from non-Unicode applications, use the "Paste As..." option 
in the Edit Menu of the WinCALIS Composition Editor, WinCALIS Author, or UniEdit and select the 
appropriate coding standard to convert from. Then highlight the word or phrase to look up in the normal 
way, using the default "Highlighted Text" as Source. 

 

Match Case 
Will match lower case or upper case by default. If unchecked, will ignore case in finding matches. Since 
the WinCALIS system understands case relations in all the world's alphabets by consulting a table, case-
sensitive searches are considerably faster than searches which ignore case. 

Drop-down Listbox Options 
 

Match What: 
•  Any Part of An Entry 

The search will match any part of an entry, including phrases, words, and sequences of as few as three 
letters occurring anywhere in a word. This is the broadest search scope. This is useful when looking up 
words which are not likely to occur at the beginning of an entry, such as suffixes like English "-ment" or "-
tion," or when using the dictionary "in reverse," to look up words which occur in definition fields. For 
example, in a Spanish-English dictionary, one would use this option along with "Search In: Everywhere" to 
look up the English word "house" in order to find its Spanish equivalent. It will find all cases where the 
word "house" occurs. 

 

When looking up hanja Chinese characters in the Korean-English dictionary, this option should be used 
along with either the  "Search in: Main Entries" option (will match only hanja main entries) or the "Search 
in: Everywhere" option (will also find any hanja occurring within the definition fields). 

 

•  Start of Entry Fields 

The search will match the start of any entry field specified. For example, if "Main Entries" only are 
searched in (the default option), then "Start of Entry Fields" will match only the first letters of the Main 
Entry. This is the next broadest search scope and is the system startup default option. If all entry fields are 
searched in (the option "Everywhere"), then the "Start of Entry Fields" option will match the first letters of 
any field. 

 

This is the best mode for handling language inflection, i.e., the variation of endings for verbs and nouns--
highlight only the stem portion of a verb or noun to look up. This is also the typical search mode we use 
when looking up words in print dictionaries and glossaries. In other words, when we look up the English 
word "pruning," we scan with our eyes the main entries in a print dictionary for "prun...," until we find the 
appropriate match "prune," having regularized or "lemmatized" in our mind the "ing" form of "prune." The 
computer will not perform this lemmatization automatically, so that it will not find the match "prune," if the 
search string is "pruning." But it will find "prune" if the search string is "prun." 
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. 

•  Whole Words 

The search will match any "whole word," which is defined as a sequence of letters bounded by spaces or 
punctuation, including the hyphen. This is the second narrowest search scope. Specific language 
dictionaries may also apply special principles. For example, in the WinCALIS Korean-English dictionary, 
bound forms have been tagged with an invisible Unicode Non-Spacing Joiner, which behaves like a 
regular character, so that bound forms are ignored during a "whole word" search. 

 

•  Whole Entry Fields 

The search will succeed only if the word or phrase looked up matches an entire entry field precisely. This 
is the narrowest search scope. Matching whole entry fields has limited usefulness, but can be helpful, for 
example, in matching full main entry or pronunciation fields. 

Button Options 
 

Search Again 
Reinitiates a search using the current search options. It is often advisable during a lengthy search for too 
broad a search string to press the Escape key and narrow the search somewhat. For example the on-line 
dictionary search engine would find over 9000 matches for the search item "giv" in the Japanese-English 
dictionary, since "giv" is the marker for a Japanese given name.  

 

Save Settings 
Retains the current search options for subsequent searches during the current WinCALIS session. 

 

Close 
Closes the dialog box. You can also close the dialog box by pressing the Escape key. 

 

Help 
Calls up On-line Help.  
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Printing a Document 
You can use the WinCALIS printer to print any Unicode document produced in the WinCALIS Composition 
Editor, the WinCALIS Author Scratchpad, or UniEdit, including a  *.CAL or the contents of a window saved 
as a file on disk. The WinCALIS Author and Student Workstations come with the WinCALIS Multilingual 
TrueType Printer program (MLPTT.EXE), for printing text in any language and script on any printer, using 
TrueType fonts. 

 

WinCALIS TrueType Printer Program (MLPTT.EXE) 
You may use the TrueType Printer for printing any text for which you have a Unicode-compliant TrueType 
font. This includes most modern fonts. To receive updates on character sets, please contact Humanities 
Computing Laboratory or its agents. 

 

When you choose Print (Alt+F,P) from the TrueType Printer File menu a dialog box opens.  Within the 
printing dialog box, you will be presented with the following menu items: 

 
Print... 

Using the Print menu option you may print any text file. 

• To print a WinCALIS *.CAL script or text generated in the Scratchpad: 
•  Start the program by clicking on its icon in the WinCALIS Pangaea group. 

•  From the File menu, choose Print (Alt+F,P) to open a dialog box. 

•  Next, using the Open option in the File menu, open the file you wish to print. 

•  From the File menu, choose Print to print the document or Print Preview to view the 
document before printing. 

 

Print Preview 

Print Preview shows an entire page at a reduced size.  You can check page breaks, position of text and 
layout.  When you choose Print Preview (Alt+F,P) from the File menu, WinCALIS printing module displays 
a Document dialog box with the following menu items:  

Print Prints the document. 
 
Next Page Displays the next page. 
 
Previous Page Displays the previous page. 
 
Two Page Displays two pages at once. 
 
Zoom In Controls portion of the page you 

see in your document window.  
Allows you to magnify part of a 
page. 

  
Zoom Out Controls portion of the page you 

see in your document window.  
Allows you to reduce part of a 
page. 
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Close Closes the File menu and 
returns you to the Multilingual 
Printing dialog box. 

 

Print Setup... 

Printing options are printer-specific settings, including resolution, color, orientation, text quality, and others. 
For additional information on changing the settings, consult your Windows manual. 

 

Print Settings... 

The default settings for margins, paper size, and page orientation are set so you can produce attractive 
documents without having to alter the settings.  
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Language Reference Manuals 

Arabic and Hebrew (Right-to-Left) Scripts 
Right-to-Left and Left-to-Right Languages Basic Information 
Cursor Position 

The position of the cursor at the beginning of a line is determined by the direction of the chosen language.  
For example, if you choose Arabic the cursor will appear on the right side of the window.  If before typing, 
you switch to English the cursor will flip to the left of the window. 

Cursor Movement  

The direction the cursor moves is determined by the first non-neutral/directional character of the line.  If 
the first character encountered by the UniEdit editor is of type left to right, the cursor will follow that 
direction until the line break (you press Enter) even if the language type has changed in the middle of the 
line.  The same holds true if the first character the UniEdit editor encounters is of the form right to left.  In 
those instances in which a neutral character begins a line UniEdit will not make a judgment until it 
encounters the first non-neutral character. 

Text Order 

Although the directional movement of the cursor does not change within a line, all text will appear in its 
proper order.  For example, if the cursor is moving from left to right and you change to a language written 
from right to left, the text will be ‘pushed’ out from the cursor point.  If you switch languages again the 
cursor will jump over the text it ‘pushed’ out and continue the line.  This will occur in the same manner if 
the cursor is moving right to left 

Switching Directions 

When mixing right-to-left text and left-to-right text, a maximum of 13 changes of direction is permitted per 
line (between hard returns).  
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Chinese 
There are three different Chinese input methods available: 

•  Pinyin Phonetic Conversion  

•  Cangjie Input Based on Character Shape 

•  Character Input through Browsing Unicode 

Of these, the normal method for typing and editing text is the first, pinyin phonetic method, which has 
many sophisticated features to enhance efficiency. The other methods are intended to supplement pinyin 
input, when you need to type a rare character, or a character the pronunciation of which you are uncertain. 

There is also a keyboard available for typing the Chinese Phonetic Alphabet (“Zhuyin Fuhao” or 
“Bopomofo”) characters. This is not a method for entering Chinese characters. 

 

The Pinyin Phonetic Input Method 
This technique is a phonetic conversion method, based on entering Modern Standard Chinese in phonetic 
transcription in the Pinyin romanization, with or without tones.  WinCALIS Author editor takes the pinyin 
text and converts it into the accurate Chinese characters each time you press the space bar or another 
conversion function key after typing the phonetic version of a Chinese word or character. 

Note: When mixing Chinese with any Roman-script language (such as English), a space, parenthesis, or other 
punctuation mark should separate the Roman language from the pinyin in order to obtain a proper conversion. 
 

Conversion Preference 
WinCALIS Author editor takes any unconverted pinyin to the left of the cursor and converts it when the 
space bar is pressed.  If the string of characters to the left of the cursor does not constitute a valid pinyin 
syllable or syllables, a message “Invalid Pinyin” will appear on the screen.  

WinCALIS Author handles the conversion process through a lookup table connected to an internal 
dictionary of Pinyin-Hanzi equivalents, with over 40,000 entries, including about 17,000 Chinese 
characters in both simple (modern) and complex (traditional) styles, as well as polysyllabic words.  If the 
correct character(s) cannot be determined, because there are several homophones with the same pinyin, 
a Chinese Selection dialog box will appear and display some homophone alternatives, arranged in order 
of descending frequency.  

 

To Convert or Not to Convert? 
In order to convert a collection of pinyin words previously typed, place the cursor at the end of the pinyin 
phrase to be converted and press the space bar or other appropriate function key.  If a match can not be 
found within the dictionary, a message “Invalid pinyin” is displayed.  Either press the space bar or use the 
mouse and click on the OK button to clear the message.  You can move the cursor back one syllable at a 
time, until part of the phrase is converted, then convert the remaining phrase or choose individual syllables 
and convert them one at a time with the [F7] or [F8] function key. 

 

Watch Your Tones! 
When typing Chinese in WinCALIS, the words must not contain any spaces or hyphens in pinyin 
transcription.  Enter tone marks with the number keys 1-4, then press the most suitable of several different 
Convert keys.  The internal dictionary will search for a correct character translation and try to match what 
you have typed.  A Chinese translation is either inserted at the cursor position of your text, or if more than 
one possible word is detected the Chinese Selection dialog box will appear and you can choose the 
appropriate homophone.  To indicate your selection click the mouse on the word of your choice, or press 
the space bar to make the Selection Window active, move up and down the list with the arrow keys until 
the desired word is highlighted, then press Enter.  You can cancel the window without making a selection 
by pressing the ESC key.  
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What is Your Pinyin Status? 
After each conversion, the correct toned pinyin is displayed in the Chinese Status Bar at the bottom of the 
screen.  The display of the pinyin text is intended to help you become familiar with the entry that was 
successfully converted by WinCALIS, so that you may make an informed choice in situations where there 
is some uncertainty as to the correct pinyin form, tone, and so on.  This is particularly handy when you 
type a pinyin form without tones and press the F8 key for an all-tone search of the dictionary.  By typing a 
toned form you can usually avoid the need to select from the homophone selection window. 

You have a number of options for converting pinyin to characters.  Most of the options are selected with 
either the space bar or one of the function keys. 

 

Functions of the Space Bar 
When Chinese is the selected language in WinCALIS or WinCALIS Author, the space bar functions as 
follows:  

•  Chinese Space 

When there is no pinyin text preceding the cursor, the space bar inserts a blank space, the length of one 
Chinese character, which is equal to over two English or pinyin-size characters, at the current cursor 
position. 

•  Convert-Word Key 

When the space bar is pressed after typing a word in pinyin transcription including the proper tones, 
WinCALIS will search its internal dictionary for a free-form word which fully matches the typed pinyin 
pronunciation, including tone: e.g., , , etc.  All characters which are only bound forms (parts of words, e.g.) 
are excluded, with the exception of the special case of capitalized proper nouns.  If more than one word 
with the same pronunciation (homophone) is found, the choices are displayed in the Chinese Selection 
dialog box.  If you do not see the desired word in the Chinese Selection window, particularly in the case of 
single characters, cancel the window by pressing the ESC key, then press function key F7 for a full 
character search.  Or simply press F8 for an all-tone search (tone is ignored).  

If a proper noun, such as a surname (e.g., Zhèng), the name of a dynasty (e.g., Táng), or a place name 
(e.g., Beijing), is typed with an initial capital letter, it is converted directly when the space bar is pressed, 
even if it is a bound form or there are other non-proper-noun homophones.  If there are two or more such 
matches (e.g. Zhang, Zhang), they are displayed in a selection window. 

 

Selecting Options from the Chinese Selection Dialog Box 
When a Chinese Selection box is displayed in the screen, a word can be selected by using the arrow keys 
to move from the first initial highlighted pinyin to the desired word as an alternative to using the mouse. 

The vowel ü (u-dieresis) (u with two dots over it) is typed with the ‘v’ key or CTRL + u. The rare vowel ê (e-
circumflex) is typed with CTRL-e. Each of these vowels is also modifiable by the tone marks 1-4. 

When tone marks are added to a syllable, they are automatically placed over the correct vowel in each 
syllable, as long as they are typed after the first occurring vowel in each syllable.  By convention, students 
should be encouraged to enter the tone right after the vowel it will appear over (like dotting an “i” or 
crossing a “t” immediately in printing) or at the end of each syllable (like dotting “i”s and crossing “t”s after 
the end of a word in handwriting). 

Certain phrase-final punctuation marks also serve as convert keys during Chinese input, thus making it 
unnecessary to first press the space bar, then press the desired punctuation mark key. (Not yet 

implemented.) These marks include the period (o), clause comma (,), serial comma (`), exclamation point 

(!), question mark (?), and “yuandian” (• ). Each of these marks is typed by pressing the designated key 
on the keyboard, which is also used for the smaller corresponding English punctuation marks during 
English input.  This is also true of the Chinese-spaced quotation mark and Chinese space. 
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Other punctuation marks unique to Chinese are entered by pressing special keys.  These are as follows:  

 

All keyboard key assignments can be displayed by clicking on main menu Help then selecting menu item 
Keyboard Help. A virtual keyboard picture will come up on the screen. 

 

Chinese Function Keys 
You can use the function keys on your keyboard to perform many tasks faster: 

F1 Get help on the selected command, dialog box, or message 

F2 Highlight the character to be accented (Accent Overstrike Key) 

F3 Switch between two currently used languages 

F4 Reselect (“Oops”) key. (WinCALIS) 

If a word is incorrectly converted, press F4 immediately to display the Selection 
Window dialog box.  Reselecting the proper word from the Selection Window will 
automatically replace the incorrectly converted word. 

 Save current script file and continue editing (WinCALIS Author) 

F5 Look up highlighted word in On-line Dictionary 

F6 Expand Scope of Selection (Selection Window) 

Broadens the range of choice in the Chinese Selection Window when pressed during 
display of a Chinese Selection window. 

Allows student to give up (WinCALIS) 

F7 Character Search 

Initiates a dictionary search for all entries in the dictionary which match the typed 
pinyin, including tone, regardless of whether they are free words or bound morphemes. 

F8 All-tone Dictionary Search 

Initiates a dictionary search or all characters or words which match typed pinyin, 
regardless of tone; any tone marks displayed will be ignored.  In All-Tone mode, 
initiates a search for only those characters or words with the tone typed. 

F9 Reselect (“Oops”) key. (WinCALIS Author and UniEdit) 

If a word is incorrectly converted, press F9 immediately to display the Selection 
Window dialog box.  Reselecting the proper word from the Selection Window will 
automatically replace the incorrectly converted word. 

F10 Default Selection/Duplicates the last word entered.  

Avoids selection from the Chinese Selection window by automatically selecting and 
displaying either the most common among two or more homophone words or the one 
most recently selected from a Chinese Selection window (ignores bound forms); each 
time a different selection is made, that becomes the new “default” value.  If pressed 
without any pinyin at the cursor, F10 repeats the last selection made from a selection 
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window (useful for reduplication, or for quick conversions of the same word in multiple 
locations). 

F11 Play Audio (WinCALIS) 

F12 Play Video (WinCALIS) 

  

Alt+F3 Set Cache/No-Cache Mode  

In Cache mode, entries selected from the main dictionary on disk are added to a 
temporary cache, and displayed even in No-Disk mode along with memory-dictionary 
entries.  No-Cache mode disables this feature. 

Alt+F4 Close the application 

Alt+F5 Set Convert/No-Convert (literal Pinyin) 

In Convert mode, pinyin text at the cursor is converted into Chinese characters.  In No-
Convert mode, pinyin text is left unconverted. 

Alt+F7 Alternate between Word and Character Mode.   

In Word Mode, pressing the space bar searches for words (free forms) only.  In 
Character Mode, pressing the space bar searches for all forms, both free and bound. 

Alt+F8 Alternate between using the space bar for Tone Mode and  All-Tone  Mode.   

In Tone Mode, pressing the space bar searches for toned forms only.  In All-Tone 
Mode, pressing the space bar searches for all forms, regardless of tone. 

Alt+F9 Alternate between Simple and Complex character style.   

 Changes the conversion of the space bar and other encode keys between complex-
style (traditional) and simple-style (modern) characters. 

Alt+F10 Alternate between Default and No-Default Search.   

In Default Mode pressing the Space Bar converts the default form either the most 
frequently occurring form or the most recently selected form) without any Selection 
Window.  In No-Default Mode pressing the space bar displays a Selection Window. 

Alt+F11 Displays the Chinese Dictionary Search Option Dialog Box. 

Alt+F12 Alternate between Disk Mode and No-Disk Mode.   

In Disk Mode, pressing the space bar immediately searches both the memory and disk 
dictionaries, producing a larger selection window, with more selections. In No-Disk 
Mode, pressing the space bar searches the memory dictionary and the cache for 
matching entries.  Single entries are directly converted.  If there is a Selection Window, 
further entries from the main disk dictionary are displayed by pressing the “More” 
button or F6. 

 

Your favorite settings may be saved as part of the WinCALIS “desktop” in WinCALIS Author, by clicking 
on Script, Desktop, Save.  The original settings are “Word, Tone, No-Default, Cache, Convert, Simple,” 
which for the typical author or student user should produce the most efficient and accurate encoding of 
pinyin phonetic input into Chinese characters. 

 

Chinese Status Bar 
When Pinyin-to-Hanzi is the current language keyboard, a Status Bar at the lower left corner of the screen 
displays the current settings for Chinese input.  
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Figure 5: Chinese Status Bar 

  

 

These settings can be changed by clicking on the buttons with the mouse, by pressing the corresponding 
Alt + function key combination, or by displaying the Chinese Dictionary Search options dialog box with 
Alt+F11 and clicking on the desired check box.  You can view the following in the Status Bar: 

the WORD/CHARACTER button,  

the TONE/ALL-TONE button,  

the DEFAULT/NO-DEFAULT button,  

the NODISK/DISK button,  

the CONVERT/NO-CONVERT (PINYIN) button,  

the CACHE/NO-CACHE button,  

the SIMPLE STYLE/COMPLEX STYLE button,  

the NEURAL NETWORK/NO-NEURAL NETWORK button and  

the PINYIN word, showing the correct toned form of the last word converted from Pinyin to Hanzi. 

 

Special Pinyin Forms 
Certain words occur so often that in addition to their regular forms, they have special alternative toneless 
or non-standard pinyin forms which make them easy to enter, without the need for selection from the 
Homophone Selection Window.  Here is a list of some of these ad hoc forms.  Note: This list includes just 
a sample of the neutral-tone “particles” which are normally typed without tone, such as “le,”  “ne,” “zhe,” 
etc. 
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Text in pinyin transcription also can be entered in your document, with or without tonal diacritic marks, by 
clicking on the NO-CONVERT button or pressing Alt+F5.  This should facilitate the production of printed 
teaching materials, glossaries, and dictionaries. 

 

National Phonetic Alphabet (“Zhuyin Fuhao” or Bopomofo”) 
Under the Chinese language submenu, selection of the “Bopomofo” language enables entry of the 
National Phonetic Alphabet symbols widely used in Taiwan, and commonly known as bo-po-mo-fo, in your 
text.  The keyboard mapping is the standard one used in Taiwan.  Note that this is not a bo-po-mo-fo input 
method, but rather a way of entering these symbols in your text, such as might be desired in a glossary or 
annotated text. 

 

Zhuyin Fuhao-Pinyin Correspondence Table 
For users familiar with the Chinese Phonetic Alphabet (“Zhuyin Fuhao” or “Bopomofo”), but not with Pinyin 
romanization, the following chart of rough equivalents may be useful: 

 

The Cangjie Input Method 
Summary of Main Principles 

The Cangjie method of computer input, which is also known as the Dragon method, is a fast, reliable 
alphabetic typing method for Chinese characters, based on their shape, without regard to their 
pronunciation. It was named by the inventor of the method, Chu Pang-fu, in Taiwan, after the legendary 
inventor of writing in Chinese antiquity, Cangjie (in Japanese, pronounced Sôketsu).  

We have created for WinCALIS and WinCALIS Author an extended, more user-friendly version of the 
original Cangjie method, which makes better use of the Windows graphical interface and mouse. You can 
select this form of character shape-based entry under the L:[Language] menu, by selecting the “Cangjie 
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(by shape)” keyboard in the Chinese submenu, the “Kanji by shape” keyboard in the Japanese submenu, 
or the “Hanja by shape” keyboard in the Korean submenu. 

When you select one of these keyboards, a dialog box appears. You can enter the letter-symbols 
representing component shapes either by typing them from the keyboard in the text box or by clicking on 
the piano-keyboard-style buttons, which show the letters and their corresponding shapes. 

Here is a description of the essentials of the original Cangjie method:  

The Cangjie method allows use of the ordinary computer keyboard to encode Chinese characters, by 
assigning 24 of the 26 letters of the Roman alphabet to represent the most common component elements 
of Chinese characters, grouped into 24 archetypal categories, each with a full-character label.  Every 
Chinese character has a unique Cangjie code of from 1 to 5 letters.  A space typed after a sequence of 
letters signals the computer system that the code is complete and initiates a lookup routine.  (No space is 
required after a five-letter code.)  

The letter “X” is a special symbol used in a small number of cases to disambiguate two characters which 
would have the same Cangjie input code.  The letter “Z” is used in some versions of the Cangjie method 
to signal a user-defined character or phrase, or at the end of a Cangjie, as a disambiguator, like an “X” at 
the beginning. (WinCALIS uses both of these systems somewhat arbitrarily. Originally, “X” at the 
beginning was used uniformly, but now “Z” at the end is used instead for recent additions, since this fits 
the new user-friendly interface better.) 

Mnemonic symbols 

 The 24 letter-symbols belong to four broad mnemonic categories: 

•  traditional Chinese natural philosophy (the seven heavenly luminaries and their correlates in 
the five “elements”) 

      (A) (“sun”)       (B) (“moon”)      (C) (“metal”)      (D) (“wood”) 

      (E) (“water”)     (F) (“fire”)      (G) (“earth”) 

•  character stroke-types 

      (H) (“left-downward sloping stroke”)      (I) (“dot”)      (J) (“cross”) 

      (K) (“criss-cross”)      (L) (“vertical”)       (M) (“horizontal”) 

      (N) (“hook”) 

•  the human body 

      (O) (“man”)      (P) (“heart/mind”)      (Q) (“hand”)      (R) (“mouth”) 

•  typical character shapes 

      (S) (“box open on the side”)      (T) (“pair”)       

      (U) (“box open on top”)      (V) (“angle `V’ shape”)       

      (W) (“large box”)       (Y) (“dot plus line”) 

As may be seen from some of the above examples, several of the letters also have a mnemonic 
association through their own shapes:  

•  “V” represents V-shaped components 

•  components looking like half a square “S” are represented by “S” 

•  U-shaped components are represented by “U” 

•  a small “l” is an example of a vertical stroke, represented by “L” 

•  a “dot” is suggested by the “dot” of the lower-case “i” 

•  the hook or angle of the “N” represents hook-shaped components 

 
Order of Encoding 

In entering the Cangjie code, the order of letters is similar to, but not completely identical with, the 
traditional stroke-order of Chinese characters.  A character is built up left-to-right, top-to-bottom, and from 
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outside to inside.  When a character is so complex that it has more than the necessary number of 
components to uniquely identify it, the left-hand side and the first and last components of the right-hand 
side are usually encoded, with the middle of the right-hand side omitted.  

In a typical character with a “radical” component on the left side, the radical is encoded with either one 
letter for the entire radical, or two letters, representing its first (top) and last (bottom) component parts. 
The remaining part of the character is encoded with the minimum number of letters to distinguish it from 
any other characters. 

 

Chart Showing Cangjie Composition Principles 
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Kangxi Radical Chart 
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Japanese 
Keyboards 

Once Japanese is selected as a language in WinCALIS Author or Student Workstation, five keyboard 
choices appear in the pull-down menu list.  They are: Roman-to-Kanji, Roman-to-Kana Only, JIS Hiragana 
Keyboard, JIS Katakana Keyboard and Kanji by shape. Following are descriptions of each keyboard. 

 

Roman-to-Kanji 

This keyboard, which provides the user with the most efficient and complete access to Japanese 
characters, will transform Roman characters into kana or kanji.  WinCALIS and WinCALIS Author support 
the two most common systems for transliterating Japanese in Roman characters: 1) the Hepburn system, 
and 2) the Kunrei system. Some Japanese word-processing systems allow many non-standard ways of 
entering Japanese in romanized form (e.g., “ca” for “ka,” “jya” for “ja/zya,” etc.).  Refer to the Kana Chart 
to see how each character may be accessed in WinCALIS. Keep in mind also the peculiarities of 
transliterating Japanese, detailed in this section.   

 

Roman-to-Kana Only  

This keyboard lets you type in kana characters without going through the buffer, so you need not press 
Enter for each bunsetsu (refer to the Kana Chart to see how it accepts transliteration). It will automatically 
change Roman characters into hiragana; katakana may be accessed by pressing Shift or Caps Lock. 

 

JIS Kana Keyboards 

These keyboards transform the QWERTY keyboard into one that directly enters kana characters, 
according to the Japanese Industrial Standard. For a display of the corresponding keyboard while typing in 
WinCALIS or WinCALIS Author, click on Help, and choose Keyboard Help.  

 

 

Figure 6: Hiragana keyboard 

 

To type a voiced kana (marked with dakuten, two dots), first type the key for its unmarked unvoiced 
counterpart, then press the overstrike key, F2, then press the dakuten accent key, which is the key 
marked with double quote “ (the shifted single quote ‘ key).  See the chart for an example. 

To type a kana beginning with the “p” sound (marked with handakuten circle), first type the key for its 
unmarked counterpart, then press the overstrike key, F2, then press the handakuten accent key, which is 
the “o” key (the letter “o” suggests the little circle diacritic).  See the chart for an example. 

 

Kanji by shape 

Kanji characters are composed of “root” shapes.  Instead of retrieving a character by its pronunciation, this 
keyboard allows you to locate a character by its looks, by elements of its root structure. This is especially 
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helpful in situations where you know what the character looks like, but not how it is pronounced. The root 
structures are accessed by choosing the Kanji-by-shape keyboard, and clicking on the piano-keyboard-
style buttons.  Notice that the database requires you to preface some duplicate characters with the “X” 
key. To clear the Kanji by Shape Window, simply change your Language keyboard. 

 

Peculiarities of Typing in Japanese 
In Roman-to-Kanji keyboard,  

to get:                  type: 

 

 

Particles 

Particles must be entered by typing their literal romanization, that is, “w-o,” “h-a,” and “h-e.”  The program 
won’t distinguish between the character when it is part of a word, or when it is a particle.  

 

Typing Tiny Characters 

WinCALIS will include the small characters within words with double consonants and modified syllables, 
for example, “i-t-t-e” or “s-h-u-u-m-a-t-s-u.”  You may also get a small character by preceding the 
romanization with “x” or “l” (capitalize for katakana).  

 

Typing syllabic “n” 

WinCALIS will include the “n” character within most words; the user may need to type an additional “n” 
within other words and always at the ends of words.  So, WinCALIS will produce the proper hiragana if “k-
o-n-b-a-n” is input, but notice you must type “h-o-n-n” to close the end of that word.  

 

Long Vowels 

In order to get the long “o” sound, the user must actually type in “u,” e.g.: “k-y-o-u.”  For katakana, use the 
hyphen “-“ for vowel extensions. 

 

Typing in Katakana 
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To type in katakana, simply hold Shift or press CapsLock in the Roman-to-Kanji or Roman to Kana Only 
keyboard, or type in hiragana and then convert to katakana with the spacebar. As you may have noticed 
on the kana chart, there are a few unconventional combinations of characters. These will probably be 
used more for foreign words, e.g.: type in “f-o- - -m-u” (include the hyphen for the long vowel).  To convert, 
press the space bar, then Enter to accept the katakana conversion to the English word “form,” which is in 
the program dictionary (not in the internal dictionary).  You must type in capitals to get proper nouns in 
katakana. 

 

Numbers 

WinCALIS will convert Arabic numbers to kanji.  Simply type the digits while you are in the Roman-to-Kanji 
keyboard, press the spacebar to convert, then highlight and enter your choice of character(s).  

 

The Active Buffer 

There are important things to know about buffers when you are typing Japanese. If the characters are not 
black, you are in an active buffer and you must do something to clear the buffer. If the computer beeps at 
you, it means that you are trying to do something outside of the active buffer, and you must clear it (by 
pressing Enter) before you can continue.  

When in the Roman-to-Kanji keyboard, this is the process for entering text: 

•   When you type hiragana, the letters will appear blue (active buffer).  If you want the words 
to remain in hiragana, simply press Enter. 

•   If you want to convert the words into kanji, press the space bar, while the characters are still 
blue. Kanji will replace the words in blue and the sentence will appear red (active buffer).  If 
all conversions are correct, press Enter (Note: The maximum length of a phrase to be 
converted is 32 characters.  If you type the 32nd character, the phrase will automatically be 
converted). 

•   If any conversions are incorrect, do the following while the characters are still red.  The 
reverse video block is your bunsetsu.  Simply move the bunsetsu over the inappropriate 
conversion and press the Spacebar.  The homophone list will appear on the screen.  Move 
the arrows to the desired kanji, then press Enter.  The selected kanji will appear in the 
phrase in reverse video.  If this is correct, press Enter again. 

•   WinCALIS divides your sentence into bunsetsu blocks as its dictionary sees fit, but you may 
change these blocks.  First, convert back to hiragana by choosing it from the list (if you try 
to change the bunsetsu while there is still Kanji within the active buffer, you will get a pop up 
message reminding you to convert).  Use the shifted left arrow to mark the first bunsetsu. At 
this point, you may convert that block by pressing the spacebar, or use the arrow keys to 
“jump” from block to block.  To continue to change bunsetsu blocking, move to the block 
that you would like to adjust, and use the shifted right and left arrow keys to shrink or 
expand it. 

•   The user may find it helpful to clear the buffer (press Enter) early and often while working in 
the Roman-to-Kanji keyboard so the bunsetsu stay manageable. This will be convenient 
both for maintaining kana, and in locating the desired kanji. If the homophone list does not 
display the character you want, try changing the blocking of the bunsetsu. With use, you will 
become more familiar with how the transliteration process occurs within WinCALIS.  

Look at the following passage, and notice the bunsetsu blocks—the bars indicate the points where 
conversions may be most efficiently placed (where the spacebar should be pressed): 
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This passage includes hiragana, katakana, kanji, and punctuation, so it is a nice exercise routine for 
typing Japanese.  Notice how each bunsetsu is entered: 

 

 

The Homophone List 

When you choose a kanji from the homophone list, the program will “remember” that one and present it 
next time the same kana are entered. The kanji most frequently used will be given priority over the other 
homophones (this does not rearrange the homophone list, which is constant.  Rather, a separate user 
history file is being created and constantly updated). 

 

Typing in Two Languages 

Toggling between two languages can be done either by: clicking and dragging the mouse on the language 
choice from the options list; pressing F3 to toggle to the language at the top of the language list (usually 
English); or by clicking and dragging with the right-hand mouse button.   

 

Punctuation in Japanese 

Setting aside keyboard exploration time may make entering Japanese text easier. Because Japanese 
uses some punctuation that is exclusive to Japanese, the characters may be hidden from view on the 
standard English keyboard.  Most of the punctuation parallels the basic keyboard, but it is in a zenkaku, 
full-width form.  The keyboard layout is displayed by clicking on Help,  Keyboard Help.  See the chart for a 
sample of available marks. 

 

Kana Kode Key  
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In order to obtain a kana character below, you must type in one set of Roman letter(s) listed beneath it. 
The first line of rômaji is the Kunrei system. Where applicable, the second line is the Hepburn system, and 
the third is nonstandard.  Keep in mind the peculiarities of typing in Japanese, detailed in this section. 
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Full-width Characters 

Full width Roman characters are accessed by typing Ctrl + Shift + the character. This provides aesthetic 
appeal in situations where Roman characters are included within Japanese text.  

 

Spelling Variation In Japanese 

Note the potential for confusion on the student’s part (in the WinCALIS language instruction system) 
because of spelling variation allowable in written Japanese. The careful courseware author will anticipate 
alternative spellings along the lines of those listed below in writing correct and incorrect responses. 
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PREFERRED FORM? ALTERNATE ACCEPTABLE FORM 1  ALTERNATE FORM 2  (QUESTIONABLE) 
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Note: The path to the “history” file, which stores your most recent choice among homophone alternatives, “wcjpnhst.dic,” 
can be redefined by adding the following line to the [WinCALIS] section of the main initialization file “winCALIS.ini”:  
 

Jpnhistory=c:\winCALIS\ 
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Korean 
How to Type Hangul 

 

Select one of the Hangul keyboards in the "Korean" submenu of the "Language" menu. There are four 
different Hangul keyboards to choose from:  the Phonetic keyboard, the Standard keyboard, the Kong 
keyboard, and the Morse keyboard. 

 

The Hangul (Phonetic) Keyboard 

 

The Phonetic keyboard is the typical student keyboard.  The consonants and the vowels are arranged to 

reflect the similar sounds of the Roman alphabet.  For example, the consonant   is located on the "p" 

key, and the vowel   is located on the "a" key. Thus, it may be the easiest keyboard for a native English 
speaker to use. However, some Korean letters do not have an equivalent in English, and thus are placed 

on unused keys on the keyboard. For example, is located on the "q" key with no relevance to sound 

(but a mnemonic association with the shape of the letter "Q").  Likewise, looks a little like a "Z" on its 

side, so it is on the "z" key; and   , which is romanized  (a "double u") is on the "w" key. The user 
must become familiar with these "exception" letters. 

 

 

Figure 7: Phonetic keyboard (unshifted) 

 

The Hangul (Standard) Keyboard 

 

The Standard keyboard, as suggested by its name, is the standard keyboard in Korea (the Korean 
typewriter keyboard). Thus, it is probably the keyboard that a native Korean would be familiar with.  It is 
divided into two parts:  The vowels are located on the right half of the keyboard, and the consonants are 
located on the left half of the keyboard. 
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Figure 8: Standard keyboard (unshifted) 

 

The Hangul (Kong) Keyboard 

 

The Kong keyboard is separated into three parts:  The initial letters (consonants, such as  , , etc.) 

are placed on the right third of the keyboard.  The medial letters (vowels such as  , , etc.) are 
placed on the middle third of the keyboard.  The final letters (consonants) are on the left third of the 
keyboard. The user must be aware of these differences.  For example, although the initial and the final 

consonants look the same ( , an initial on the "h" key, and  , a final on the "s"  key), they cannot be 
used interchangeably. 

 

 

Figure 9: Kong keyboard (unshifted) 

 

The Hangul (Morse) Keyboard 

 

The Morse keyboard, among the four, requires the greatest number of keystrokes to type.  There are no 
compound vowels, only simple.  Thus, the user must combine the simple vowels to make compound 

vowels.  For example, .  In addition, the vowels and consonants are scattered about the 
keyboard in relation to frequency of use and convenience of layout of the particular letter (similar to the 
arrangement of the English keyboard).  
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Figure 10: Morse keyboard (unshifted) 

 

Hangul-Hanja Conversion 
 

Hangul-to-Hanja  (F8) 

 

To convert the syllable or word to the left of the insertion point (the blinking caret) written in Hangul into its 
Hanja equivalent, press the F8 function key, or click on the menu item Tools, Language Options, Korean 
Options, Hangul-to-Hanja. (One of the Korean language keyboards must be the currently selected 
keyboard.)  The conversion engine scans to the left from the insertion point attempting to match up to four 
Hangul characters. If there are homophone equivalents, they will appear in a Selection Window. Choose 
the desired equivalent. 

 

For example, to convert  to  , press F8 with the insertion point to the right of 

 .  

 

Hanja-to-Hangul  (F7) 

 

To convert the syllable or word to the left of the insertion point (the blinking caret) written in Hanja into its 
Hangul equivalent, press the F7 function key, or click on the menu item Tools, Language Options, Korean 
Options, Hanja-to-Hangul. (One of the Korean language keyboards must be the currently selected 
keyboard.)  The conversion engine scans to the left from the insertion point attempting to match up to four 
Hanja characters. If there is more than one Hangul equivalent (i.e., there is more than one reading for the 
Hanja), they will appear in a Selection Window. Choose the desired equivalent. 

 

For example, to convert  to  , press F7 with the insertion point to the right of  . 

 

You can also enter Korean Hanja characters through two other methods: 

 

Shape-based coding: The Hanja By Shape Keyboard 
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Under the Language or L:[Language] menu, select the "Hanja by shape" keyboard in the Korean 
submenu. For details on this method see “The Cangjie Input Method”. Cangjie, the legendary inventor of 
writing in ancient China, is known in Korean as Ch'anggyôl. To clear the Cangjie Window, simply change 
your Language keyboard. 

 

  

Figure 11: Hanja by shape keyboard 

 

 

HOW TO TYPE KOREAN TRANSLITERATION 

 

The Hangul (Morse) Keyboard 

 

In order to type the special o with breve ( ) and u with breve ( ) characters necessary for the Korean 
Ministry of Education or McCune-Reischauer romanization, you may choose the "Korean Transliteration" 
keyboard in the Korean submenu, as well as one of the other general transliteration keyboards. You can 
type the base vowel "o" or "u," then press the overstrike key F2, then type the mnemonic accent key for 

the breve "u"; or you can type them directly by pressing "q" or "f" for " " and "x" or "v" for " " 

 

 

Figure 12: Korean Transliteration keyboard 
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Appendix A: 
Selected Keyboard Layouts 
 

This section is for referencing the layouts of some selected language keyboards in WinCALIS and 
WinCALIS Author.  Not all the available keyboards are shown. The following keyboards are shown in their 
unshifted state (unless noted “shifted”).  

 

English/W.Europe 

 

 

[African] Amharic 
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[Arabic script] Arabic-CALIS 

 

 

[Arabic script] Persian-CALIS 

 

 

[Europe (other)] Armenian 
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[Europe (other)] French keyboard, shifted 

 

 

[Europe (other)] Georgian 

 

 

[Europe (other)] German keyboard, shifted 

 

 

[Europe (other)] Greek-Phonetic 
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[Europe (other)] Hungarian, shifted 

 

 

[Europe (other)] Italian keyboard, shifted 

 

 

[Europe (other)] Spanish keyboard, shifted 

 

 

[Europe (other)] Turkish, shifted 
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[Cyrillic] Belarusian 

 

 

[Cyrillic] Bulgarian 

 

 

[Cyrillic] Russian-CALIS 

 

 

[Cyrillic] Russian-Phonetic 
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[Cyrillic] Russian-Standard 

 

 

[Cyrillic] Serbian 

 

 

[Cyrillic] Ukrainian 

 

 

[Chinese] Bopomofo 

 

 



WinCALIS Guide 

75  

[Chinese] Cangjie (by shape) 

 

 

[Special Fonts] Form/Symbols 

 

 

[Hebrew script] Hebrew-Israel 
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[Hebrew script] Hebrew-Phonetic 

 

 

[Hebrew script] Yiddish 

 

 

[Korean] Hangul (Kong) 

 

 

[Korean] Hangul (Phonetic) 
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[Korean] Hangul (Standard) 

 

 

[Asian (other)] Thai-Chiangmai 

 

 

 

 





WinCALIS Guide 

79  

Index 

A 

Accents and Diacritics........................................................... 28 
accent keys ........................................................................ 29 
The overstrike key............................................................. 29 

Arabic.................................................................................... 43 
Author version of WinCALIS ............................................... 15 

B 

Bopomofo (Chinese) ............................................................. 49 

C 

Cangjie .................................................................................. 49 
Chinese.................................................................................. 44 

Function Keys ................................................................... 46 
Chinese Options .................................................................... 20 
Cloze task type 

responding to..................................................................... 27 
Composition Editor ............................................................... 22 
Conversion 

from older *.cal files ......................................................... 31 
Copyright ................................................................................ 7 

D 

Dictionaries ........................................................................... 35 
Dictionary Mode Window..................................................... 22 
Directories 

Changing ........................................................................... 25 

F 

Farsi ...................................................................................... 43 
French ............................................. See Accents and Diacritics 

G 

German............................................ See Accents and Diacritics 
Giving Up.............................................................................. 30 

H 

Hebrew.................................................................................. 43 

I 

Install 
demonstration lesson ......................................................... 12 
Optional files..................................................................... 11 

J 

Japanese ................................................................................ 55 
Kana Chart ........................................................................ 58 
Kanji by Shape .................................................................. 55 
Spelling Variation ............................................................. 60 
Typing Peculiarities .......................................................... 56 

Japanese Options................................................................... 21 

K 

Kangxi Radical Chart.............................................................52 
Katakana ................................................................................56 
Keyboards 

Selected Layouts ................................................................69 
Korean ...................................................................................64 
Korean  Options.....................................................................21 

L 

Languages 
Right-to-Left ......................................................................43 

Look Up Word.......................................................................21 

M 

Multiple Choice task type 
responding to .....................................................................26 

O 

Options...................................................................................12 

P 

Pass Back...............................................................................18 
Pass Forward..........................................................................18 
Persian ...................................................................................43 
Pinyin.....................................................................................44 
Print Settings..........................................................................42 
Printing ..................................................................................41 

*.CAL files ........................................................................41 

S 

Short Answer task type 
responding to .....................................................................26 

Spanish............................................ See Accents and Diacritics 
Status Bar 

Chinese ..............................................................................47 
Support.....................................................................................7 
System Requirements.............................................................11 

T 

True/False task type 
responding to .....................................................................26 

Tutorials.................................................................................19 

U 

Unicode 
Character Selection Box ....................................................32 

W 

WinCALIS layout 
Menu 

Help ...............................................................................23 
Language........................................................................19 
Tutorials.........................................................................19 



 

80 

Menu items 
Lesson ........................................................................... 17 
Options.......................................................................... 18 

opening screen................................................................... 14 
description of................................................................. 14 

Opening Screen 
change directory...................................................... 12, 13 
Help Menu..................................................................... 13 
Index ............................................................................. 13 
no conversions............................................................... 15 

Options menu.....................................................12, 13, 15 
Options Menu ................................................................15 
text conversions ............................................................15 

Options menu 
window defaults .............................................................15 

Z 

Zhuyin Fuhao (Chinese).........................................................49 

 


